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Preface

This documentation explains how to create and maintain business services with the optional
Service Development component of NaturalONE. It is organized under the following headings:

Release Notes Information on new features and enhancements.

Introduction About the Natural Business Services (NBS) product on the server
and its client. Prerequisites on the NBS server.

Getting Started About the demo application which can be downloaded from the NBS
server. An overview on how to download and create business
services. Folder structure in the workspace, and the available editors.

Creating New Business Services How to generate a business services together with its supporting
resources (domains and steplib chain files). Format of the file name
for a business service. Information on the business service resources
that need to be uploaded.

Creating New Domains and Steplib How to create domains and steplib chain files separately.
Chain Files

Using the Editors How to use the business service editor, the domain editor, and the
steplib editor.

Working With Business Service How to download business service resources from an NBS server.

Resources on the Server How to copy, paste, move and delete business service resources

directly on a server.
Generating Java Clients and Web ~ How to generate Java clients and web services for the business
Services services using a wizard.
Defining Security for a Domain How to view and change the security settings for the domains that
are available locally and on the server.
Adding Business Service Definitions How to register business services and their corresponding metadata
to CentraSite with CentraSite.

Setting the Preferences for Business Information on the preferences that can be set for the business
Services services.

‘J Notes:

1. The Service Development component provides code generators that can be used to generate
Natural subprograms for your business services. This is explained in the Code Generation
documentation, in the section Using the Code Generation Component.

2. To test your business services and associated Natural subprograms, you have to use the
Application Testing component of NaturalONE. This is explained in the Application Testing
documentation.

3. The Service Development component is always installed together with the Application Testing
component of NaturalONE and with EntireX. The most up-to-date EntireX documentation is




Preface

always available at hittp://documentation.softwareag.com/webmethods/entirex.htm (Empower
login required).

The Service Development component is always installed together with the Natural Construct
component of NaturalONE which provides access to Natural Construct on the server. You can
use the Natural Construct component to generate code using Construct models. This is explained
in the Code Generation documentation, in the section Using Natural Construct.

vi
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://documenta-
tion.softwareag.com. The site requires credentials for Software AG's Product Support site Empower.
If you do not have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.com with
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

Business Services
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About this Documentation

You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.asp and give us
a call.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG TECHcommunity
website at http:/techcommunity.softwareag.com. You can:

" Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation” as an area of interest.
" Access articles, code samples, demos, and tutorials.

= Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

® Link to external websites that discuss open standards and web technology.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Business Services 3
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Release Notes

These Release Notes pertain to the Business Services functionality of Natural ONE Version 8.3.

What's New in Version 8.3.1

This version contains several error corrections. New functionality is not provided.

What's New in Version 8.3.2

This version contains several error corrections. New functionality is not provided.

What's New in Version 8.3.3

This version contains several error corrections. New functionality is not provided.

What's New in Version 8.3.4

Automatic Download of Subprograms

By default, the subprograms that are used by a business service are now downloaded automatically.
This behavior can be changed using the new option Automatically download related subprograms
from Natural server in the Business Services preferences. On this occasion, the text on the Business
Services preference page has been revised. See also Business Services in Setting the Preferences for
Business Services.

Documentation

The Business Services documentation has been revised and restructured.
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What's New in Version 8.3.5

This version contains several error corrections. New functionality is not provided.

What's New in Version 8.3.8

Setting the nbs.properties File to Run a Dynamic RPC Java Class

It is now possible to set the broker wait time in the nbs.properties file. This property applies for a
web service on the client side.

For further information, see Setting the nbs.properties File to Run a Dynamic RPC Java Class in
Generating Java Clients and Web Services.
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Introduction

About Natural Business Services

NaturalONE - or more specifically, the Service Development component of NaturalONE - is the
client for the Natural Business Services (NBS) product which runs on the server. This server product
also includes Natural Construct.

When the Service Development component of NaturalONE has been installed, you can generate
and maintain business services on the client, and you can upload the generated business service
resources to your Natural Business Services environment on the server.

Before you read this documentation, it is recommended that you make yourself familiar with the
Natural Business Services documentation, which is available separately. The most up-to-date
Natural Business Services documentation is always available at http://documentation.software-
ag.com/natural/nbs.htm (Empower login required).

Managing Business Services with NaturalONE

Each business service combines a group of methods related to a common business entity, such as
a customer or order. Processing for the methods is supplied by either existing or wizard-generated
Natural subprograms.

The Service Development component of NaturalONE provides a wizard for generating business
services. But you can also download your existing business services from a Natural Business Services
environment on a mainframe or UNIX server.

This wizard generates all default resources that are required by the business service. These include:

* Domain
Domains are used to group related business services. Each business service is assigned to a do-
main. For each domain, you can define specific security permissions.

® Steplib Chain
A steplib chain defines the libraries in which the Natural objects for a business service are stored.
The libraries are accessed in the order in which they are listed in the steplib chain. By default,
all business services in a domain are accessed using the same steplib chain.

® Methods
The wizard allows you to generate a specific subprogram type (for example, a subprogram that
provides browse functionality for a Natural object) or no subprogram at all. The type of method
that is generated depends on the subprogram type that you select in the wizard.

After you have generated or download a business service, you can generate Java clients and web
services from your business service.
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Note: For information on how to test your business services, see the documentation for the

Application Testing component of NaturalONE.

Prerequisites

Server

To use the Service Development component of NaturalONE, a Natural Business Services (NBS)
environment is required on the server. For information on installing and configuring a Natural
Business Services environment on a server, see the Natural Business Services documentation.

Although business services can be generated into a project connected to the local Natural runtime
environment, they cannot be executed in the local Construct runtime environment. You have to
upload the business services to the server so that they can be tested with Application Testing
component of Natural ONE.

NaturalONE only supports Natural RPC servers. A Natural RPC server is a service which runs
under a broker and which routes the requests from the NBS client to the NBS server. Responses
(data) generated on the NBS server are then sent to the client via the Natural RPC server. The
Natural RPC server definitions are set in the EntireX preferences.

Natural Business Services Version 5.3.1 Service Pack 20 or higher is required to execute business
services via the Natural RPC server. However, if you want to make use of the latest server func-
tionality (for example, the Object-Maint-Enhanced-Subp model), Natural Business Services Version
8.2 is required on the server.

Business services created on a Natural RPC server can be used in other NBS environments.

Note: If you want to test business services and subprograms, see NaturalONE's Application

Testing documentation for information on the prerequisites.
Client

If the Service Development component of Natural ONE has not yet been installed, use the Software
AG Installer to install it.

The Service Development component is always installed together with the Application Testing
component and the Natural Construct component of NaturalONE.

Business Services 11
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Getting Started

Demo Application

Natural Business Services on the server provides sample business services. If you are new to

business services, it is recommended that you download the following items from your Natural

Business Services (NBS) server, and then make yourself familiar with the programming logic of

the downloaded files:

" DEMO steplib

®" DEMO domain

" SYSBIZDE system library

® Sample DDMs where the names start with NSCT (for example, NCST-CUSTOMER) in the SYSTEM
library

See also the information on the supplied demo applications in Getting Started with Natural Business
Services, which is part of the Natural Business Services documentation.

The topics below provide a quick overview of how to download or create a business service. See
the remainder of this documentation for more detailed information.

If you are new to NaturalONE, you can find more detailed information on the standard Natural ONE
functionality (such as creating projects and libraries, or mapping server environments) in Using
Natural ONE. See also the references below.

Downloading a Business Service

Business services have to be stored in Natural projects. Other than with the regular Natural objects,
it is not possible to download business services into a new project. If you do not want to download
the business services into one of your existing projects, you have to create a new project first.

> To download a business services

1  Inthe Natural Server view, map an environment in which Natural Business Services has been
installed. See also Mapping a Natural Environment in Using Natural ONE.

2 Inthe Navigator view, create a Natural project which is associated with a Natural Business
Services (NBS) server. Since you have mapped this environment in the previous step, you
can simply select this server from the second page of the project wizard. At this point, you
need not specify any more options in the project wizard. See also Creating a New Project Using
a Wizard in Using Natural ONE.

3 Go back to the Natural Server view and expand the node for the mapped environment.

14 Business Services



Getting Started

A top-level node with the name Business-Services is shown if this is an environment in which
Natural Business Services has been installed. To view the currently defined domains, expand
the Domains node. To view the business services in a domain, expand the node for a domain.

Example:
=H Natural Server &2 =N gk Sl
4 =1 Mainframe with NBS -

4 [ Business-Services
- [ Steplibs
4 = Domains
4 .. DEMO

|_-@ Calculator (1.1.1)
E@ Calculatorfdvance (1.1.1)
[y Customer (1.1.1)
|__@ CustemerCreditAnalysis (1.1.1)
|_-@ CustomerWithContactData (1.1.1)
E@ CustomerWithContactData (2.1.1)
[y ErrorMessageTesting (1.1.1)
[y FlipString (1.1.1)
|_-@ GreatestCommonDenominator (1.1.1)
E@ Crder (1.1.1) -

m

By default, the Business-Services node is only shown when an installation of Natural Business
Services can be detected on the server. This behavior can be changed in the Business Services
preferences. See also Installation in Setting the Preferences for Business Services.

4  Select a business service, invoke the context menu, choose the Add to Existing Project com-
mand. Select the Natural project in the resulting dialog box.

The selected business service is downloaded into the specified project. By default, all required
resources which belong to a business service are automatically downloaded. This also includes
the related subprograms. This behavior can be changed in the Business Service preferences.
See also Business Services in Setting the Preferences for Business Services.

If the Construct runtime project does not yet exist in your workspace, you are asked whether
you want to add it to your workspace. You can then choose the Yes button to create a new
project with the name "ConstructRuntime". This project contains, for example, the error
message texts stored in the CSTMSG library or the screen prompt texts stored in the CSTLDA
library. The modules in this project will eliminate compile and parsing errors caused by
missing Natural Construct resources. See the Code Generation documentation for more detailed
information on the Construct runtime project.

5 To find out which resources are used by a downloaded business service, go to the Navigator
view, double-click the downloaded business service to open it in the business service editor,
and then check the resources listed in the Dependencies view. If resources are listed as
"<Unknown>" in this view, double-click each unknown resource and confirm to download it

Business Services 15



Getting Started

from the server. Or manually download the resources from the mapped Natural Business
Services environment. Afterwards, make sure that the library containing these resources is
defined in your steplib chain file. See also Using the Steplib Editor.

In Navigator view, invoke the context menu for the business service and choose Testing >
Test Business Service. If any items are still missing, you can view the corresponding messages
in the Error Log view. If the required items can be found, the test editor appears. See the Ap-
plication Testing documentation for detailed information on how to use the test editor.

Creating a Business Service Using the Wizard

Business services have to be stored in Natural projects. If you do not want to create the business
service in one of your existing projects, you have to create a new project first.

> To create a business service

In the Navigator view, create a Natural project which is associated with a Natural Business
Services (NBS) server. If you have already mapped this environment previously, you can
simply select this server from the second page of the project wizard. At this point, you need
not specify any more options in the project wizard. See also Creating a New Project Using a
Wizard in Using Natural ONE.

All Natural objects that are required by your business service need to be stored in a Natural
library. Therefore, create a Natural library in the new project. See also Creating Libraries in
Using Natural ONE.

By default, the business service wizard does not generate subprograms. In this case, you have
to program the entire logic of your application manually. However, you can specify that a
specific type of subprogram is to be generated (for example, an Object Browse or Object Maint
subprogram type). In such a case, you have to specify the Natural library into which the
subprogram and other related resources are to be generated.

If you intend to generate an Object Browse or Object Maint subprogram type, you also have
to specify a DDM. Make sure that this DDM exists in your project before you invoke the
wizard.

| Note: If you select to generate a subprogram, additional pages are shown in the wizard

that are not explained in this documentation. See the Code Generation documentation
for detailed information on these subprogram types.

Select the project in which you want to create the business service, invoke the context menu
and choose Business Services > New Business Service. Proceed as described in Creating
New Business Services later in this documentation.

16
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Getting Started

Note: The Business Services context menu is available when the Service Development

component of NaturalONE has been installed.

Folder Structure in the Workspace

In a Natural project, all business services are stored in a folder named Business-Services. This
folder cannot be renamed. For example, when you have downloaded the DEMO domain and the
SYSBIZDE library from the server, your project may look as follows:

4 Ié- MpBusinessservices-=ibm2-4T82 (1)
- [= .settings
4 [= Business-Zervices
4 [= _steplibs
E DEMO.steplib
4 = DEMO
#.. ,domain

Ly Calculatorwl.l lbsry

L Calculatorfdwancewl L lbsry

L Custornerswd 1 Lbsrs

Ly CustomerCreditinalysiswl. L lbsrs

Ly CustomerwithContactDatawl. L Lbsr

L CustomertithContactDatawd LLbsre

Lei ErrortessageTestingwllLlbsre

Ly FlipStringw1.1.1 bsry

Ly GreatestCommaonDenominatorwl. 1lbsry

L Orderswl.llbse

L Ordersed. L1 bsrw

Ly Productwl L Lbsry

Ly Stringhdanipulationwll Lbsrs

L Warehousenwl 1 Lbsey
(7 arrayBaseballPlayerswvllLbsry
4 = Matural-Libraries
- [ SWSBLEDE

w2l hatural
el project

The Business-Services folder contains a subfolder named _steplibs and one or more domain
folders, where each folder has the name of the corresponding domain (the above example shows
the domain folder with the name DEMO).

® The _steplibs folder cannot be renamed. It contains one or more steplib chains. These are the
files with the extension .steplib. Each steplib chain file defines the steplibs that can be used by
the business services. The file DEMO.steplib in the above example defines SYSBIZDE as the steplib.

Business Services 17
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® Each domain folder contains the following:

® A file with the name .domain, which defines the steplib chain to be used. This file cannot be
renamed.

As a rule, each domain has a steplib chain file with the same name. For example, the DEMO
domain has a steplib chain file with the name DEMO.steplib.

® One or more business services. These are the files with the extension .bsrv. Each .bsrv file
defines the Natural subprograms which implement the service methods. These subprograms
must be located in one of the defined steplibs.

A\  Important: Even though Natural ONE allows you to rename some of the above-mentioned

folders and files, it is recommended that you do not rename them after you have defined
the business logic.

Editors

You can view and change the business service resources in the Business-Services folder with the
following editors which are provided with Natural ONE:

= Steplib Editor
You invoke this editor by double-clicking a file with the extension .steplib. This corresponds to
the context menu command Open With > Steplib Editor.

* Business Service Editor
You invoke this editor by double-clicking a file with the extension .bsrv. This corresponds to the
context menu command Open With > Business Service Editor.

* Domain Editor
You invoke this editor by double-clicking a file with the name .domain file. This corresponds to
the context menu command Open With > Domain Editor.

Each editor provides two tabs. On the first tab, which is always shown by default, you can change
the information if required. The second tab is the XML tab, which is read-only and can only be
used to view the underlying XML.

@ Caution: Always use the editors provided with NaturalONE to edit the above-mentioned

business service resources. Manually editing these files with different editors can potentially
cause problems.

For more detailed information, see Using the Editors later in this documentation.
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Creating New Business Services

Using the Business Service Wizard

With NaturalONE, it is only possible to create business services locally, in a Natural project. It is
not possible to create them directly on the NBS server.

You create business services using a wizard. The business service wizard generates many resources
required by the service. These include the business service file, the domain folder and .domain file,
and the steplib chain file.

By default, the wizard checks for existing business services on the Natural server and displays a
warning message if they already exist. It generates the supporting resources (domains and steplib
chain files) if they do not yet exist locally. This default behavior can be modified in the Business
Service preferences. See Business Services in Setting the Preferences for Business Services.

> To use the business service wizard

1  Inthe Navigator view, select the Natural project in which you want to create the new business
service.

2 Invoke the context menu and choose Business Services > New Business Service.
Or:

From the File menu, choose New > Other. In the resulting dialog box, expand Software AG
> Business Services, select Business Service and choose the Next button.

The New Business Service dialog box appears.
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Creating New Business Services

i

E Mew Business Service = =2 |EH
Define Business Service Details :
Enter the information needed to generate a new business service,
Matural project name:

Business service details

Domain: DEMO -
Service name:  Mew5ervice

Version: 1.0.0

[ . =

MyBusinessbervices Browse...

Description: |

N

ack Mext = Finish Cancel

m
f
[

3  Specify the following information:
Option Description
Natural project name | The project in which the business service is to be created. If you have selected
a project before invoking this dialog box, the project name is automatically
shown in this text box.
Domain If your project already contains one or more domains, a domain name is

provided. If you do not want to use the provided domain, you can either type
the name of a new domain that is to be created, or - if more domains are defined
in your project - you can select the name of a different domain from the
drop-down list box.

Service Name

The default name "NewService" is provided. Type an appropriate name for the
new service.

Version

The default version number "1.0.0" is provided. Type an appropriate version
number for the new service.

The version number consists of three parts that are separated by dots. It must
match the following format:

Business Services
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Option Description
nn.nn.nn
Description Type a brief description of the service.

Choose the Finish button if you do not want to generate a subprogram for your business

service.

Or:

Choose the Next button if you want to generate a subprogram for your business service.

When you choose the Next button, the following dialog box appears.

i

@

E Mew Business Service = '@

Define Subprogram Type
Choose the subprogram type to be generated.

Indicate the subprogram type te be generated:
@ Meone (do not generate subprograms)

) Object browse

) Object maint

) Object skeleton

| < Back Mext = Finish l I Cancel

If you want to generate a subprogram, select one of the following options:
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Option Description

Object browse |Generates a subprogram that provides browse functionality for a Natural object.
Parameter data areas are also generated. You have to specify the name of an existing
DDM for this purpose.

Object maint  |Generates a subprogram that maintains complex data objects and updates all entities
within an object. Local data areas and parameter data areas are also generated. You
have to specify the name of an existing DDM for this purpose.

Object skeleton |Generates a skeleton subprogram which uses the input/output parameters and default
methods that you specify in the wizard.

If you select one of the above options, additional pages are shown in the wizard that are not
explained in this documentation. For detailed information on the above modules and the
options that you have to specify in the wizard, see the Code Generation documentation.

| Note: The above modules can also be generated when you invoke the Code Generation

context menu for a project.

Choose the Finish button to generate the business service file and, if specified, the subprograms.
If they do not already exist, the associated domain and steplib chain files are also generated.

The newly created business service is automatically shown in the business service editor. For
more information (for example, on how to add methods to the business service), see Using
the Business Service Editor.

Next Steps

After you have generated a business service using the wizard, you can proceed as described below:

1.
2.

Make sure that your domain information is correct. See Using the Domain Editor.
Create all libraries that are to be used as steplibs.

Make sure that your steplib chain file defines all steplibs that are to be used. See Using the
Steplib Editor.

If you have not selected to create a subprogram in the business service wizard: create the sub-
program that implements the methods that are to be used by your business service.

Add all required methods to the business service. See Using the Business Service Editor.
Upload all business service resources. See Uploading the Business Service Resources.

Test the business service. See NaturalONE's Application Testing documentation for detailed in-
formation.
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File Name Format for Business Services

The name of a business service file is composed of the service name and a version number, separated
by a dot. The version number consists of three parts that are also separated by dots. When you
rename a business service file, you have to keep this structure. The name must match the following
format:

name.vnn.nn.nn.bsrv
For example, MyCustomer.v3.2.1.bsrv or MyOrder.v1.10.20.bsrv.

It is recommended that you do not rename a business service file after you have defined the
business logic.

Uploading the Business Service Resources

All objects that are addressed by a business service must be stored in an FNAT or FUSER system file
on the server. You use the standard Natural ONE functionality to upload the business service file
and all other generated resources (such as the domain file and steplib chain file) to the server.

When a business service is uploaded, it is placed into the NBS repository on the server (LFILE
135). During the upload, it is not checked whether the objects that are used by the business service
already exist. When the business service is executed, however, it is checked whether all defined
subprograms are available.

When the option Build Natural projects automatically is enabled in the Natural preferences, the
appropriate server is automatically updated each time you save a business service resource in the
Eclipse workspace or when you add a new business service resource. When this option is disabled
in the Natural preferences, you have to update the server manually. The business service files,
domain files and steplib chain files need not be stowed or cataloged on the server. Therefore, you
can simply use the Upload command.

If you change your steplib definitions after the upload (for example, when you define a new library),
you have to make sure that the updated steplib chain file is uploaded to the server.

If you save your data in the repository of a version control system, you have to make sure that
this data is available in Natural when the service is executed.
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General Information

Domains and steplib chain files are automatically generated in your project when you create a
business service using the wizard. If you need more domains and steplib chain files, you can
generate them as described below.

Creating a New Domain

Each business service is assigned to a domain, which groups the services according to access
privileges and user-defined criteria.

> To create a new domain

1  Inthe Navigator view, select the Natural project in which you want to create the new domain.
Or:

Select the Business-Services node in that project.

2 Invoke the context menu and choose Business Services > New Domain.
Or:

From the File menu, choose New > Other. In the resulting dialog box, expand Software AG
> Business Services, select Domain and choose the Next button.

The New Domain dialog box appears.
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e

E Mew Domain

Matural project

MName:
Description:

Steplib:

Enter the information needed to generate a new business service domain,

Define Domain Details -m

Domain details

= [ =]

0

[ il

name: MyBusinessSer\rices | Browse... |

DEMO -

Cancel

3  Specify the following information:

Option

Description

Natural project
name

The project in which the domain is to be created. If you have selected a project
before invoking this dialog box, the project name is automatically shown in this
text box.

Name

Type the name of the domain.

By default, the wizard checks the server connection to verify whether the domain
currently exists. If it does, a warning message is shown. You can now decide whether
you want to overwrite the content of the existing domain on the server, or whether
to enter a different name in order to create a new domain. This default behavior
can be modified in the Business Service preferences. See Business Services in Setting
the Preferences for Business Services.

Description

Type a brief description of the domain.

Steplib

It is recommended that the steplib chain file has the same name as the domain. If
you want to generate a new steplib chain file that has the same name as the domain,
type that name here.

The drop-down list box provides for selection all steplibs that are currently defined
in the project. You can also select an existing steplib chain file.

Business Services
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4 Choose the Finish button.

A new domain folder with the specified name is shown within the Business-Services node
of the project. A file with the name .domain has been created in that domain folder. The .domain
file specifies the steplib chain file to be used. If you have specified the name for a new steplib
chain file, this file has been created in the _steplibs node.

Creating a New Steplib Chain File

A steplib chain file defines a set of Natural libraries that a Natural RPC server must access to call
a subprogram or proxy. The server accesses the libraries in the order they are listed in the steplib
chain file.

When you create the steplib chain file as described below and if your environment is protected
by Natural Security, you have the advantage that you can specify an existing library in your project
from which to copy the steplib definitions.

Keep the following in mind:

® If your project belongs to a secure environment, steplibs can only be defined in the library
properties.

® If your project does not belong to a secure environment, steplibs can only be defined in the
project properties.

~ To create a new steplib chain file

1 Inthe Navigator view, select the Natural project in which you want to create the new steplib
chain file.

Or:
Select the Business-Services node in that project.
Or:

Select the _steplibs node in that project.

2 Invoke the context menu and choose Business Services > New Steplib.
Or:

From the File menu, choose New > Other. In the resulting dialog box, expand Software AG
> Business Services, select Steplib and choose the Next button.

The New Steplib dialog box appears.
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i

[ Mew Steplib

Steplib details

Matural library:

Define Steplib Details -_T >

Enter the information needed to generate a new business service steplib,

Matural project name: r‘-ﬂ}fELl sinessServices Browse...

Mame: MEW _STEPLIE

Copy Matural Security steplib definitions

= [E =]

i

[ =

Browse...

Finish l I Cancel

3  Specify the following information:

Option

Description

Natural project

The project in which the steplib chain file is to be created. If you have selected a

name project before invoking this dialog box, the project name is automatically shown
in this text box.

Name Type the name for a new steplib chain file over the default name.

Natural Library  |This option is only available when Natural Security is active in the associated

server environment. In this case, steplibs can only be defined in the library
properties.

If you want to copy the steplib definitions from a specific library of the current
project, type the name of that library. Or choose the Browse button, to select that
library from a dialog box.

If you do not specify a library name, the generated steplib chain file will list a
steplib library with the same name as the steplib chain file (only the first 8
characters of that name are used). This steplib may not yet exist in your project.

4  Choose the Finish button.
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The new steplib chain file is created in the _steplibs node, and the steplib editor is invoked,
showing the definitions for the new steplib chain file. See also Using the Steplib Editor.
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General Information

Specific editors are available for the following business service resources:

® business service files
® domain files

= steplib chain files

Each editor provides two tabs. On the first tab, which is always shown by default, you can change
the information if required. The second tab is the XML tab, which is read-only and can only be
used to view the underlying XML.

@ Caution: Always use the editors provided with NaturalONE to edit the above-mentioned

business service resources. Manually editing these files with different editors can potentially
cause problems.

If you want to edit the above-mentioned business service resources, they must be available locally
(that is, in the Navigator view). You cannot edit or view them directly on the server (that is, in the
Natural Server view). If you want to edit or view the business service resources that are stored
on the server, you have to download them first. See Downloading Business Service Resources
from a Server. After editing the resources, you can return them to the server using NaturalONE's
standard functionality (for example, with the Upload command).

Using the Business Service Editor

The business service editor is used to view and change the following aspects of the business service
definition: subprogram proxy and subprogram used by the business service, description of the
business service, and the methods used by the business service.

> To edit the business service definition

1 Inthe Navigator view, expand the Business-Services node of your project.
2 Expand a folder which has the name of a domain.

3  Double-click a file with the extension .bsrov.
Or:

Select a file with the extension .bsrv, invoke the context menu and choose Open With >
Business Service Editor.

The business service editor appears. Example:
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[y Calculatorvd 1.1.bsr &2 = g

Overview !

+ General Information

This section describes general information about this business service,

Domain: DEMO
Service: Calculator
Version: 111
Default proxy: CALCY
Default subprogram: CaLc
Description:

Performs simple calculator functions, In addition a success flag is set if -
the selution is greater than the success criteria,

m

+ Method List

This section lists the
methods used by this
business senvice.

Add Add
Divide

Multiply
Subtract

Overview | XML

4 You can change the following general information:

Option Description

Default proxy The name of the subprogram proxy used for this service. This proxy is used by

default if a method that is listed in the editor does not use its own method proxy
(see below).

Proxies are used for the communication between the client and the server. They
invoke Natural business services from a client. Proxies can only be generated
using Natural Business Services on the server, for example, by using the

Subprogram-Proxy-Client model. See the Natural Business Services documentation
for further information.
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Option Description
Default The name of the subprogram that implements the service methods. This
subprogram subprogram is used by default if a method that is listed in the editor does not use

its own subprogram (see below).

Important: You must specify a default subprogram for the service if any of the
listed methods do not specify a subprogram.

Description A brief description of the business service.

5 To view or change the information that is defined for a method, select the method in the
method list.

The lower part of the editor now shows additional information. Example:

+ Method List + Method Information

This section lists the This section describes method informaticon.

methods used by this

business service. Method name: Add
Add Add Method description:  Adds two numbers together., -
Divide
Multiply |Remove| -
Subtract Method proxy:

Method subprogram:
Method steplib:

Cverview | XML

6  You can change the following method information:

Option Description

Method name The name of the method as defined in the subprogram.

When you have created a new business service that does not use a subprogram,
a method with the name "Default" is initially shown in the method list. After

you have created the subprogram which implements your methods, you have
to change "Default" to the name of an actual method used in your subprogram.

Method description |A brief description of the method.

Method proxy The name of the subprogram proxy used for this method. If defined, the method
proxy is used instead of the default proxy.

Method subprogram|The name of the subprogram that implements this method. If defined, the
method subprogram is used instead of the default subprogram.
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Option

Description

Method steplib

The name of a steplib chain file used by this method. You need only specify a
method steplib if the default steplib chain file that is defined in the .domain file
is not sufficient.

7 You can use the following command buttons:

Command Button | Description
Add Adds a method. You have to specify the required method information (see above).
Remove Removes the selected method.

8  Save your changes using the standard Eclipse functionality (for example, press CTRL+S)

Using the Domain Editor

The domain editor is used to view and change the description and to define a different steplib

chain.

> To edit the domain definition

1 Inthe Navigator view, expand the Business-Services node of your project.

2 Expand a folder which has the name of a domain.

3  Double-click the .domain file.

Or:

Select the .domain file, invoke the context menu and choose Open With > Domain Editor.

The domain editor appears. Example:
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£ domain 2 =

Overview

+ General Information

This section describes general information about this domain.

Domain: DEMO

Descriptiocn:  Demo objects

Steplib chain: DEMO

Cwerview | XML

4 You can change the following information:
Option Description
Description |The description of the domain.
Steplib chain |The name of the steplib chain file to be used. This corresponds to a file with the extension
.steplib in the _steplibs node of your project.
It is possible to enter the name of steplib chain file that does not yet exist. Keep in mind
that there is no plausibility check when editing the domain definition. Such a check is
only performed during runtime when the business service is executed.
5  Save your changes using the standard Eclipse functionality (for example, press CTRL+S)
36
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Using the Steplib Editor

The steplib editor is used to view, change and reorder the steplibs in a steplib chain. A steplib
contains the subprograms that implement the service methods. You can use any library in your
project as a steplib. You can also use libraries from other projects as steplibs.

When a business service is executed, it always accesses information from the server. Therefore, it
isimportant that the business service can find the libraries in the appropriate FUSER or FNAT system
file.

~ To edit the steplib definition

1 In the Navigator view, expand the Business-Services node of your project.
2 Expand the _steplibs node.
3 Double-click a file with the extension .steplib.

Or:

Select a file with the extension .steplib, invoke the context menu and choose Open With >
Steplib Editor.

The steplib editor appears. Example:
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E DEMO.steplib 52 = B
Overview

+ General Information

This section describes general information about this steplib chain.
Steplib: DEMO
w Library List

This section lists the step libraries
within this steplib chain.

SYSBIZDE Add
Remowve
Up

Down

Cwerview | XML

4  To view or change the information that is defined for a steplib, select the library in the library
list.

The lower part of the editor now shows additional information. Example:
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w Library List + Library Information
This section lists the step libraries This section describes library
within this steplib chain. information.

SYSBIZDE Add Library name:  5Y¥SBIZDE

Remove Library DBID: 0

Library FMR: 0

il

Down

Cwerview | XML

5  You can change the following library information:

Option Description

Library name |The name of the library.

Library DBID |The ID of the database which contains this library.

Normally, you need not define a DBID and FNR because all required objects are stored
on the server which is defined in the project properties. This is only required in

advanced configurations when uploading to the server (for example, when you have
defined a business service with several methods where the corresponding subprograms

are stored in different libraries, and the libraries are stored in different databases and
files).

Library FNR |The number of the database file which contains this library. Only required in advanced
configurations when uploading to the server.

6  You can use the following command buttons:

Command Button | Description

Add Adds alibrary to the steplib chain. You have to specify the required library information
(see above).

Remove Removes the selected library from the steplib chain.

Up Moves the selected library up one position in the library list.

Down Moves the selected library down one position in the library list.
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7  Save your changes using the standard Eclipse functionality (for example, press CTRL+S)

Using the Dependencies View

When a business services resource (for example, a business service file) is shown in the active ed-
itor, the Dependencies view shows the dependencies between that resource and other business
services resources and/or Natural resources.

To Dependencies i3 = | ®m laz e = B
4 |__@ DEMO:Calculatoral 1l
JiE SYSBIZDE:CALC

4 [ SYSBIZDE:CALCY
2E SYSTEM:CDAPROX2 {ConstructRuntime}
2E SYSTEM:CDPDA-M2 {ConstructRuntime}
3£ SYSTEM:CDLPROXC {ConstructRuntime}
L SYSTEM:CDLSPCON {ConstructRuntime}
£ SYSTEM:CDLSP {ConstructRuntime}
lE SYSBIZDE:CALC
s <Unknown>:SUBPROGRAM-PROXY

4 2. DEMO
E DEMO

When a supporting resource (domain or steplib) cannot be found locally using the project steplib
chain and project references, "<Unknown>" is displayed with the name of the resource. You can
download the unknown object using the Open command from the context menu or by double-
clicking the object.

If an unknown module is not shipped with the Construct runtime project, either manually
download it from the server or create it locally. If the module is shipped with the Construct runtime
project, add the project. See the Code Generation documentation for more detailed information on
the Construct runtime project.

Object models such as SUBPROGRAM- PROXY are marked with the following icon: "™s. These models
cannot be downloaded using the Open command in the context menu (or by double-clicking).
Normally, you would not download such a model unless you want to maintain the model yourself.

For more information on the Dependencies view (for example, on the icons in the local toolbar),
see the description of the source editor in Using Natural ONE.
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Downloading Business Service Resources from a Server

Using the Natural Server view, you can download existing business service resources from a
Natural Business Services (NBS) server into a Natural project. When Natural Business Services
has been installed in the server environment, a Business-Services node is shown for the mapped
environment, containing further subnodes for steplibs and domains.

=H Matural Server &3 - = S = 0

4 =H Mainframe with NBS
4 [= Business-Services
- [= Steplibs
. = Domains
. [= Construct
- L[ User Libraries
- L System Libraries
- L DDMs

By default, the Business-Services node is only shown when an installation of Natural Business
Services can be detected on the server. This behavior can be changed in the Business Services
preferences. See Installation in Setting the Preferences for Business Services.

> To download business service resources

It is only possible to download business service resources into an existing Natural project. They
cannot be downloaded into a new Natural project. If you want to download business service re-
sources into a new project, create that project first.

1  Inthe Natural Server view, map the required NBS server. See also Mapping a Natural Environ-
ment in Using Natural ONE.

When mapping to an NBS server, you have to enter a user ID and password. These credentials
must be defined to Natural Business Services security on the server, and they must have the
appropriate permissions.

2 Inthe Natural Server view, select the Business-Services node to download the entire contents
of that node.
Or:
If you only want to download selected items, select the Steplibs folder, the Domains folder,
or any single items in these folders.

3 Invoke the context menu and choose Add to Existing Project.
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The Add Business Service Resources to Existing Project dialog box appears.

-

E Add Business Service Resources to Existing Project | = || & |[+53]

Select Project:

[= ConstructRuntime

IE'H'M}rBusinessﬂewices

TE'H'M}rTestPrDject

=2 NaturalONE Hello World Sample Application

0K ] ’ Cancel

4  Select the project into which you want to download the business service resources and choose
the OK button.

The definitions for all selected services, domains, and steplibs are downloaded into the selected
project. In the Navigator view, you can view them in the Business-Services node of the project.
If this node does not yet exist, it is automatically created during the download.

] Notes:

1. By default, any supporting resources (domains and steplib chain files) and related subpro-
grams that were not selected are automatically downloaded (for example, the steplib chain
file for a selected domain is automatically downloaded). You can change this behavior in
the Business Services preferences. See also Business Services in Setting the Preferences for
Business Services.

2. If the Construct runtime project does not yet exist in your workspace, you are asked
whether you want to add it to your workspace. You can then choose the Yes button to
create a new project with the name "ConstructRuntime". This project contains, for example,
the error message texts stored in the CSTMSG library or the screen prompt texts stored in
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the CSTLDA library. The modules in this project will eliminate compile and parsing errors
caused by missing Natural Construct resources. See the Code Generation documentation for
more detailed information on the Construct runtime project.

3. If you want to check whether any steplibs are missing in your project after the download,
you can open the file which defines the steplib chain (that is, the file with the extension
.steplib). When the library list contains any steplibs which are not available in your project,
you should download them from the server. See Using the Steplib Editor for further in-
formation.

Managing Business Service Resources Directly on the Server

In the Natural Server view, you use the following context menu commands with your business
service resources:

Command

Description

Copy

Copies the selected business service files to the clipboard so that they can be used with a
subsequent Paste command.

Paste

Pastes the copied business service files into a different domain of the same mapped environment.

It is not possible to paste the business service files into any other node which is not a domain
node of the same mapped environment.

Move

Moves the selected business service files from the current domain into a different domain of the
same mapped environment. The Move Objects dialog box appears in which you have to select
a destination.

Even though the Move Objects dialog box may also list other mapped environments, it is only
possible to move the selected business service files into a different domain of the same mapped
environment.

Delete

Deletes the selected business service files, domain folders or steplib chain files. You have to
confirm this action.

Caution: When you delete a domain folder, you also delete all business services contained in

this domain.

Note: Domain folders and steplib chain files cannot be copied, pasted or moved.
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Using the Generate Java Client Wizard

After creating business services locally or downloading them from an existing server installation,
you can generate Java clients and web services for the business services using the Generate Java
Client wizard.

Using this wizard, you can

Generate Java clients

You can develop Java client applications that access Natural Business Services server components
via dynamic RPC. The wizard creates Java clients from the business service files in a Natural ONE
project and then generates the Java client interface objects used by the Java client to access the
server components.

Generate web services

You can generate web services from the business service files in a NaturalONE project. The
generated objects are web service archives (files with the extension .aar). They can be deployed
in a Web Services Stack runtime environment and registered in CentraSite. Web service client
applications can then access these web services and expose business logic implemented by the
Natural server components.

| Note: See also the Web Services Stack documentation, which is available separately. When

working with the Software AG Designer, you can find it in the online help under Software
AG Designer Guides.

> To use the Generate Java Client

4

In the Navigator view, select the business service file (that is, a file with the extension .bsrv)
from which you want to generate a Java client or web service.

Invoke the context menu and choose one of the following commands: Generate Java Client
or Generate Web Service.

The Generate Java Client wizard is shown for both commands. The only difference is that
specific options are already preselected depending on the chosen command.

Specity all required information as described in the topics below. Some options require addi-
tional information. In such a case, you have to use the Next button repeatedly to proceed from
the first page of the wizard to the last page.

When all required information has been provided, choose the Finish button.

The different pages of the deployment wizard are described in the following topics:

= General Generation Settings
= Deploy NaturalONE Web Service
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= Connect to CentraSite
= Design Interface for Natural Subprogram

General Generation Settings

On the first page of the wizard, you define the general settings for the generation.

o o

[ Generate Java Client E==

g
£

Configure Generated Class

5 .-"\'l
o

[
k

Enter the desired project settings and parameters for the class to be generated

The generated class will be based on Calculatoral 1.1.bsrv service:

Project Parameters

Source folder | Browse...

il

Package name: Browse...

[ ] Generate Web Service (.aar] file
Web Service
Deploy the generated Web Service

Register the generated and deployed Web Service

Java Data Class
[] Add trimi{]) to String getters

Generate JUnit test file
["] Redesign the interfaces

@:l < Back Mext = Finish

Source folder
The source folder in which to generate the Java class. This folder must already exist. This can
be the folder for any type of project (for example, a Java project), or a folder within a project.
You can choose the Browse button to select the folder from a dialog box.

If you select a project as the source folder, the wizard will automatically create and use <pro-
Ject -name>/Java/src as the source folder. In addition, the wizard will set the output/compilation
folder to the bin folder corresponding to the source. For example, if the source folder is set to
Java/src, then the output/compilation folder will be set to Java/bin.
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Package name
The name of the Java package. The package does not have to currently exist. You can either
type the name for a new Java package, or you can choose the Browse button to select an existing
package from a dialog box.

Generate Web Service (.aar) file
This option is preselected if you have invoked the wizard using the Generate Web Service
command.

If selected, the web service file (that is, a file with the extension .aar) will be created when the
class is generated.

Deploy the generate Web Service
Only enabled when Generate Web Service (.aar) file is selected.

This option is preselected if you have invoked the wizard using the Generate Web Service
command.

If selected, the wizard will display an additional page on which you have to specity the desired
destination. See also Deploy Natural ONE Web Service.

If deselected, you can configure the web service to use WS-Security. See also Configuring the
Web Service to Use WS-Security.

Register the generated and deployed Web Service
This option is only shown when the CentraSite plug-in is installed. Only enabled when Deploy
the generated Web Service is selected.

If selected, you can register the generated and deployed web service with CentraSite. The
wizard will display an additional page on which you have to specify the required information
for connecting to CentraSite. See also Connect to CentraSite.

Add trim() to String getters
If selected, a Java trim statement (for example, string_variable.trim()) will be added to
each String property getter method in the generated Java Data class (<name>Data.java). The
trim statement will return a copy of the String property with leading and trailing whitespace
omitted.

Generate JUnit test file
If selected, a JUnit test file is generated which contains test functions that correspond to each
method in the business service. For more information on the generated JUnit test file, see
Testing the Java Class.

Redesign the interfaces
If selected, the wizard will display an additional page on which you can redesign the interface
for Natural subprograms. For example, you can change the default IDL directions or you can
select which portions of a redefined field are to be used. See also Design Interface for Natural
Subprogram.
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| Note: When an exception occurs as the result of one of your actions in the wizard, this may

happen because required resources cannot be found. Check whether all required resources
are located in your workspace and that your steplib chain file lists the required library.

Deploy NaturalONE Web Service

This page is shown when the option Deploy the generated Web Service has been selected in the
wizard. It displays the default parameters for the WS-Stack runtime environment running in the
default Tomcat servlet engine. The default user credentials are shown. They can be changed at
the first logon.

P =

E Generate Java Client = @
Deploy Natural ONE Web Service -m

Please choaose the desired destination.

Mames: localhost-10010 -
URL: http://localhost 10010/ wsstack/sagdeployer
User admin

Password: eeses

() < Back “ Mext = ‘ [ Finish l I Cancel

Confirm the name and location of the WS-Stack runtime environment, and confirm the user cre-
dentials.
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For more information on deploying a Web service or changing logon credentials, refer to the Web
Services Stack documentation.

Connect to CentraSite
This page is shown when the option Register the generated and deployed Web Service has been

selected in the wizard. You can then register the generated and deployed web service with
CentraSite.

.

E Generate Java Client o || =

Connect to CentraSite - server information m

3 Please complete your user identification.
[ il

Host: localhost
Port: 53305
Product IC: Centrasite

Repository Path:  WebServicesStack

Usen |

Password:

Organization: | -

'ﬁ:‘ | < Back | lext = lish | Cancel

Enter your CentraSite user ID and password, and select the organization. For more information
on CentraSite, see the CentraSite documentation.

| Note: Default values for this page are defined in the Business Service preferences. See

CentraSite in Setting the Preferences for Business Services.
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Design Interface for Natural Subprogram

This page is shown when the option Redesign the interfaces has been selected in the wizard. You
can then redesign the interface generated for a Java client.

Eﬁeneraiela\ra(:ﬁent [F= IE
|
Design Interface for Natural Subprogram
Set IN,QUT,INCUT directions, select REDEFINEs and suppress parameters to design the interface. You can use the context menu, =)
Quick Fix or buttons,
Natural Subprogram: | CALC - IDL Library: SYSBIZDE
4P cALC +ELR|EBE
Matural Parameters IDL Parameters
- G
P E;F 4 <% INPUT-DATA InOut
G 2 #FFUMCTION (A30) @p FFUMNCTION (A30)
5! 2 #FIRST-NUM (N5.2) 27 FFIRST-NUM  (N5.2)
ﬁ 2 #SECOND-MUM (M5.2) @p FS5ECOMD-NUM  (N5.2)
E 2 #5UCCESS-CRITERIA (M5) Map to InOut -» @p #5UCCESS-CRITERIA  (M5)
4 &1 0UTPUT-DATA 4 45 QUTPUT-DATA InQut
%2 2 #RESULT (N11.2) P #RESULT (M11.2)
B 2#TIME(M) — & STIME (T)
% 2 #5UCCESS (L) “et bonstant 47 #5UCCESS ()
« Natural Subprogram Source
fﬂﬂg Source |
.5 DEFINE DATA PARAMETER -~
77 2 #FUNCTION (A30) |
25 2 #FIRST-NUM (N5.2)
20 2 #SECOND-NUM (N5.2) T
b I

@ vet> | [ Finish [  Concel |

The upper left pane on this page shows the parameters of the Natural subprogram to extract from.
For each Natural subprogram parameter, you can choose an operation as described in the following
table.
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Task

Procedure

Change the default IDL directions for the
generated Java client

In the upper left pane, select the level 1 parameter that you
want to change and choose Map to In, Map to Out or Map to
InOut. The operation is reflected in the right pane. Continue
to define level 1 parameters as required.

Natural parameters that are mapped in the interface are
displayed with a green tick.

Define which parameters redefined in the
Natural PDA are part of the extracted
interface

In the upper left pane, select the REDEFINE base parameter or
any REDEFINE path and choose Map to InOut.

Suppress unnecessary parameters, which
creates a less cluttered IDL client interface
and minimizes the amount of data
transferred at runtime

In the upper left pane, select the parameter and choose
Suppress.

Natural parameters suppressed in the interface are displayed
in italic type.

The upper right pane displays the extracted interface (IDL). The IDL directions will be inserted
as top-level parameters (level 1) in the interface definition for the Natural subprogram.

The bottom pane is used for reference purposes. It displays the Natural subprogram source and,
if available, its PDA sources, each in a separate tab. To reserve more space for viewing the upper
panes, you can collapse the bottom pane when it is not needed.

For more information on this page, refer to the EntireX documentation.

Generated Folder Structure in the Workspace

The folders and files that have been generated by the wizard are shown in the Navigator view.
The following example shows a package with the name "Calculator" which is stored in the Java/src
folder of the project - a web service has not been generated:
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F I@H MyBusinessServices->ibma2-4782 (3)
- [= .settings
- [= Business-Services
a = lava
- == bin
4 [= src
4 [= Calculator
CalculatorData.java
Calculatorservice.java
CalculatorserviceT est,java
nbs.properties
- = lib
- &= Matural-Libraries
X| .classpath

&

w2 -natural
W2l project

If you have also selected to generate a web service, the package contains an additional .aar file as
shown in the following example:

a = Calculator
[J] CalculatorDatajava
B CalculatorService.aar
[J] CalculatorService java
[J] CalculatorServiceTest java

The following files are generated into the Java/src folder:

* Data Class
Java class containing the PDA for the business service, which is mapped to Java. The class has
the same name as the business service followed by the string "Data". For example, Calculat-
orData.java.

* Business Service Class
Java class containing the code that communicates with the business service, as well as the Add
method. The class has the same name as the business service followed by the string "Service".
For example, CalculatorService.java.

" JUnit Class
This class is only generated when the option Generate JUnit test file has been selected in the
wizard. The class has the same name as the business service followed by the string "ServiceTest".
For example, CalculatorServiceTest.java. See also Testing the Java Class.
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" Web Service Archive File
This file is only generated when the option Generate Web Service (.aar) file has been selected
in the wizard. The file has the same name as the business service followed by the string "Service".
For example, CalculatorService.aar. See also Configuring the Web Service to Use WS-Security.

® Properties File for the Business Service
The name of this file is always nbs.properties. This file is used by the NBSSettings class to load
Broker RPC connection settings. See also Setting the nbs.properties File to Run a Dynamic RPC
Java Class.

| Note: Some of the above files are automatically opened in the corresponding editors.

Library files with the following names are generated into the Java/lib folder:

= log4j-<version>.jar
Library containing the logging functionality.

" wrappercore.jar
Library containing the helper classes and functionality for the generated Java class.

Setting the nbs.properties File to Run a Dynamic RPC Java Class

You can set the nbs.properties file to run a dynamic RPC Java class. This file is used to load Broker
RPC connection settings.

The NBSSettings class will attempt to find the nbs.properties file using the following search order:

1. Java system property nbs_properties pointing to the file.
2. Environment variable nbs_properties pointing to the file.
3. Class loader NBSSettings.

4. Context class loader.

The properties in the nbs.properties file are:

Property Description

broker.id Broker connection ID.

broker.service |Broker service endpoint.

broker.waitTime |Broker wait time.

user.id User ID to use with Broker.
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Property Description

password Password to use with Broker.

Caution: For security reasons, it is recommended that the password is not set in the

nbs.properties file. It is much more secure to set the Broker credentials
programmatically.

For example:

broker.id=Tocalhost:1971
broker.service=RPC/SRVI/CALLNAT
broker.waitTime=60S
user.id=PWRUSR

password=

Notes:

1. If the generated code is to be used in AXIS2, you must copy the nbs.properties file to the <tom-
cat>/webapps/<ws stack>WEB-INF/classes folder.

2. The default broker wait time is set to 60 seconds, if this property is not specified in the
nbs.properties file. If wait timeouts on the client side occur, the value of the broker wait time
(broker.waitTime) may be increased. To use another wait time, add the following property in
the nbs.properties file: broker.waitTime=<nnn>S (e.g. broker.waitTime=9995).

Defining Different User IDs and Passwords for Web Services

Both the user.id and password properties can use a Java class suffix (for example,
package.MyService), which allows the client to use different user IDs and passwords for different
services and/or groups of services. For example:

user.id.package.name.MyService=USERIDA
password.package.name.MyService-PWDA
user.id.package.name=USERIDB
password.package.name=PWDB
user.id=PWRUSR

password=

When the web service MyService in the Java package package . name is invoked, the user ID USERIDA
and the password PWDA will be used.

When any other service within the Java package package.name is invoked, the user ID USERIDB
and the password PWDB will be used.

All other services will use the user ID PWRUSR and no password.
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Using log4j Logging Statements in a Runtime Environment

The generated Java classes support log4j logging statements for advanced diagnostics at runtime.
If logging is being used, there is the potential for data to be visible in the log files produced in the
runtime environment. To avoid this problem, configure the com.softwareag.naturalone.gen.dynamic-
rpc.core logger file to only display warnings and above.

Example:

log4j.logger.com.softwareag.naturalone.gen.dynamicrpc.core=WARN

Testing the Java Class

When the Generate JUnit test file option is selected in the wizard, a JUnit class is generated. This
class contains test functions that correspond to each method in the business service. For example:

@Test
public void testAdd() throws Exception {
Calculator service = createService();
CalculatorData data = new CalculatorData();
//T0OD0O populate data
CalculatorData result = service.add(data);
Assert.assertNotNull("Result is null", result);
//T0D0 check result
}

//T0D0 comments have been added in the source to indicate where additional information is added
for the test. By default, the test succeeds if no errors occur during the call to the business service
and if data is returned.

Data can be added before the service method is invoked. For example:

//T0OD0O populate data
data.getCalcInput_data().set_first_num(new BigDecimal(2));
data.getCalcInput_data().set_second_num(new BigDecimal(2));

In addition, an assert clause can be included to verify that the result is correct. For example:
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//T0D0 check result
Assert.assertEquals(new BigDecimal(4),
result.getCalcOutput_data().get_result());

Tests can be invoked using standard Eclipse JUnit functionality (that is, run as JUnit test). The
environment for the test is contained in this function in the test file. For example:

private Broker createBroker() throws BrokerException {
String userID = "GUEST";
String password = "";
Broker broker =
new Broker(Demotest.DEFAULT_BROKERID, userlID,
Demotest.DEFAULT_SERVER) ;
broker.logon(password) ;
return broker;
}

Writing an Application to Use the Generated Java Class

After generating a Java class, you can write an application that uses the class to invoke a business
service. Use the following code as a template for writing the application. Read the comments for
additional information.

// Create the EntireX Broker object
Broker b = new Broker("localhost:1971","GUEST");
// Create the service class.
Calculator calcservice = new Calculator(b, "RPC/SRVI/CALLNAT");
// Create the service data class
CalculatorData calcdata = new CalculatorData();
// Set input values for the call
calcdata.getCalcInput_data().set_first_num(new BigDecimal(2));
calcdata.getCalcInput_data().set_second_num(new BigDecimal(2));
calcdata.getCalcInput_data().set_function("Add");
// Invoke a service method, passing in the data class
// make sure to catch any errors that might happen.
CalculatorData calcresult = null;
try {

calcresult = calcservice.add(calcdata);
} catch (DataException e) ({

e.printStackTrace();
} catch (BrokerException e) {

e.printStackTrace();
} catch (ServiceException e) {

e.printStackTrace();
}
// Examine the result
System.out.printin("Result is:"

+ calcresult.getCalcOutput_data().get_result());
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Configuring the Web Service to Use WS-Security

All generated services extend
com.softwareag.naturalone.gen.dynamicrpc.core.AbstractService. The default constructor
for the generated service determines which Broker credentials to use based on the following rules:

1. When WS-Security is turned on and the credentials are passed in the SOAP header, they will
be used in the call to Broker.
2. In all other cases, the settings in the nbs.properties file will be used. See also Setting the

nbs.properties File to Run a Dynamic RPC Java Class.

If you want to configure the web service to use WS-Security, do not select the Deploy the generated
Web Service in the wizard. Generate the web service (.aar) file without this option and then proceed
as described below.

~ To configure the web service to use WS-Security

Go to the Java/src folder and expand the package into which the .aar file has been generated.
Open the generated .aar file.
In the resulting editor, go to the Services tab (shown at the bottom of the editor page).

In the Modules section, select the Enable WS-Security check box.

Q. &= LW N =

In the Security section, select the following options:

* no Binding

® User Name Token (in the Token Assertions group)

~ Maodules ~ Policies
Enable WS-Addressing Choose "Save as..." to save the user defined poli
[C] Enable WS-ReliableMessaging  Inactivity Timeout | 600000 | Milliseconds Available Policies: | UserDefined

Enable WS-Security

~ Security
@ no Binding _) Message-level Security with Symmetric Binding Use Client C
) Transport-level Security with 550 (7) Message-level Security with Asymmetric Binding Enable Secure Conversation

Message-level Security Options Token Assertions
Sign Header Encrypt Body User Mame Token

{e Timestamp {500

6  Save the changes to the .aar file.

7  In the Navigator view, invoke context menu for the .aar file and choose Web Services Stack
> Deploy Web Services Package.
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The Software AG Web Services Stack dialog box appears. It shows the same information as
the Deploy Natural ONE Web Service page of the Generate Java Client wizard. For a descrip-
tion of this page, see Deploy Natural ONE Web Service.

’ E Software AG Web Services Stack = @ ﬁ
Deploy your Web Services E
Please choose the desired destination,
Mame: localhost-10010 -
URL: http://localhost:10010/ wsstack/sagdeployer
User admin

Password: sesss

Finish l | Cancel

8 Confirm the information and choose the Finish button.

On the client, you have to include the following SOAP header with the correct credentials in the
XML file. You can then test the generated web service using a SOAP engine.

<{soapenvl2:Envelope xmlIns:soapenvlZ2="http://www.w3.0rg/2003/05/soap-envelope">
<soapenvl?:Header>
<wsse:Security xmlns:soapencl2="http://www.w3.0rg/2003/05/soap-encoding”
xmins:xsd="http://www.w3.0rg/2001/XMLSchema" <
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
©
xmlIns:wsse="http://docs.oasis-open.org/wss/2004/01/0asis-200401-wss-wssecurity-secext-1.0.xsd"
>
<wsse:UsernameToken>
<wsse:Username>MyUser</wsse:Username>
<wsse:Password>MyPassword</wsse:Password>
</wsse:UsernameToken>
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</wsse:Security>
<{/soapenvl?2:Header>
<soapenvlZ:Body>

For example, you can use SoapUI to test the web service. You deploy the web service into the WS-
Stack, open the WS-Stack and display the web service in the browser. You can then use the URL
of the web service in SoapUI where you also specify the credentials.

| Note: Since user credentials will be included in the SOAP header, it is highly recommended

that you use HTTPS. For instructions on how to configure AXIS2 to use HTTPS, refer to the
AXIS2 documentation.
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General Information

Security for business services is applied at the domain level by associating a group with a domain.
Access can then be granted or denied at the domain, business service, and/or method level.

To view and change the security settings for the domains, you use the NBS Security view.

Note: For more information, see Setting Business Service Security Options in the Natural

Business Services Administration documentation. This is part of the Natural Business Services
documentation, which is available separately.

Showing the NBS Security View

The NBS Security view is not shown by default when you open the NaturalONE perspective.

~ To show the NBS Security view

1  From the Window menu, choose Show View > Other.
2 In the resulting Show View dialog box, expand the Software AG Natural ONE node.
3 Select NBS Security and choose the OK button.

Showing the Security Groups for a Domain

You can display the security groups for domains that are available both locally and on the NBS
server. For each group, you can display the business services within a group, and the methods
that are defined for a business service.

~ To show the security details for the groups within a domain

1  Inthe Navigator view or Natural Server view, select a domain.

Details about the security settings of that domain are shown in the NBS Security view.
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(2] MBS Security (DEMO domain) &3 = 08
o* ti(E) N
Group / Marme Disable Grant Revoke
- ADMIN 1
- DEMOUSRS b
- DEVS b
- USERS b

By default, the Synchronize icon () is selected in the local toolbar of the NBS Security.
When this icon is selected and you select a different domain in the Navigator view or Natural
Server view, the details for the new domain are shown in the NBS Security view. If the Syn-
chronize icon is not selected and you select a different domain, the details in the view do not
change.

¢ Tip: Asit may take some time to retrieve security details from the server, you can

deselect the Synchronize icon when you do not require these details.

2 To display the business services within a group, expand the group. Example:
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3

Ol Properties B MBS Security (DEMO domain) &2

Group / Mame

a ADMIN
. Customervl1.l
- CustomerWithContactData w111
- CustomerWithContactData v2.1.1
- CustornerCredit&nalysis v1.1.1
- FlipString v1.1.1
. Ordervl1.1
- Orderv21l
- Productvlll
- Warehousevl1.1
- ErrorMessageTestingv11.1

- GreatestCommonDenominator v1.1.1
. Calculatorvl1l

. Caleulatorfidvancewl 1l

- StringManipulation v1.1.1

- DE

#arrayBaseballPlayers v1.1.1
MOUSRS

- DEVS

- LS

ERS

Dizable

i 5 [E)

Grant

b

R &R

Revaoke

To display the methods defined for a business service, expand the business service. Example:
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5] MBS Security (DEMO domain) &3 = 0

Group / Mame Disable Grant Revoke i

4 ADMIN b
4 Customervlll
BROWSE
DELETE
EXISTS
FORMER.
GET
IMITIALIZE
MEXT
STORE
UPDATE
- CustormerWithContactData v1.1.1
- CustormerWithContactData v2.1.1
- CustomerCreditf&nalysis v11.1
- Flip5tringv11.1
- Ordervlll i

m

Changing the Settings for a Security Group

You can set the security options described in the table below. You can set them on group level for
all items in this group, on service level including all defined methods, or on method level only.

Security Option | Description

Grant Allows access to an item.
Revoke Disallows access to an item.
Disable Temporarily revokes access to an item. When the item is reenabled, the previous setting

(Grant or Revoke) is restored.

The NBS Security view shows columns for the above security options. When a security option is
set for an item, a checkmark is shown in the corresponding column.

If you change the settings for a security group, you have to update the security settings on the
server. Otherwise, the server does not know that the settings have been changed.

~ To change the security settings

»  In the NBS Security view, click a cell in the desired column.
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For example, if you have disallowed access to certain methods, this may now look as follows:

1 Properties |5) MBS Security (DEMO domain) &2 = B
:Iﬂ I="1Jf l:c:} -
Group / Mame Disable Grant Revoke T
a USERS ¥
4 Customervl.l.l
BROWSE
DELETE bl
EXISTS
FORMER E
GET
INITIALIZE bl
MEXT
STORE
UPDATE b

| Note: To save the changed security settings, you have to update them on the server.

Adding Security Groups

You can add security groups, which have previously been defined on the server, to a domain.
Keep in mind that new security groups cannot be defined on the client. This can only be done on
the server.

~ To add a security group to a domain

1  In the Navigator view or Natural Server view, select the domain to which you want to add
a security group.

2 Inthe NBS Security view, invoke the context menu and choose Add Group.

Or:

Choose the following icon in the local toolbar:
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ar
-

L]

The Security Groups dialog box appears. Example:

[ Security Groups | = [E 3]

Select a security group to add to the DEMO domain.

ADMIM
C5T
DEMOUSRS
DEVS
QANBSE2
USERS

) Cancel

@ o

3 Select the group you want to add.
4  Choose the OK button.

Removing a Security Group

You can remove a security group from a domain.

If you remove a security group, you have to update the security settings on the server. Otherwise,
the server does not know that the group has been removed.

~ To remove a security group from a domain

1 Inthe NBS Server view, select the group that you want to delete.

2 Invoke the context menu and choose Delete Group.
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| Note: You will not be asked whether you really want to remove the group. However,

this change will only become effective when you update the security settings on the
server.

Updating the Security Settings on the Server

Each time you change the settings for a security group, you have to update them on the server.

~ To update the security settings on the server

1  Inthe NBS Server view, select a group, business service or method.

2 Invoke the context menu and choose Update.
Or:

Choose the following icon in the local toolbar:
4

i}

A progress window is briefly shown as the security settings are updated on the server.
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General Information

You can register business services and their corresponding metadata with CentraSite using the
Add to CentraSite wizard. This wizard is an optional feature for NaturalONE and is only available
when the CentraSite plug-ins are installed. Refer to the CentraSite documentation for more inform-
ation.

Importing the Business Service Asset Types

Before you can add business service definitions to CentraSite, you must import the business service
asset types to the CentraSite server.

~ To import the business service asset types

1 From the File menu, choose Import.

2 In the resulting Import dialog box, select CentraSite > Archive.
3  Choose the Next button.
4

Choose the Browse button, and search for and select the file <NaturalONE-install-
folder>\Designer\eclipse \plugins\ com.softwareag.naturalone.gen.nbs.eclipse_<ver-
sion>\res\com.softwareag.naturalone.gen.nbs.centrasite_asset_types.zip.

5  Select the Finish button to import the asset types file.

Note: For more information on importing data from an archive, see the CentraSite

documentation.

Adding Business Service Metadata to CentraSite

After you have imported the business service asset types to the CentraSite server, you can add
business service metadata to CentraSite.

- To add business service metadata to CentraSite

1  Inthe Navigator view, select a business service.

You can add the metadata for all business services defined in a Natural ONE project or for
any folder or object within the project, depending on which node is selected in the Navigator
view. For example, if you select the Business-Services root node, the metadata for everything
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defined in the project will be added to CentraSite. If you select an object or folder within the
Business-Services root node, only this object or folder (and any items within the folder) will
be added.

2 Invoke the context menu and choose Business Services > Add Metadata to CentraSite.

The Add Metadata to CentraSite dialog box appears, in which you have to enter details about
the CentraSite connection.

([ Add Metadata To CentraSite = (B =
Add Business Service Metadata to CentraSite .

Enter details about the Centra&ite connection.

Connection details

Server |

User ID:

Password:

o~

N, Finish Cancel

3 Inthe Server text box, type the CentraSite connection path.

4 Inthe User ID and Password text boxes, type the user credentials for CentraSite.

¢ Tip: You can set up the default Server and User ID values in the Business Services

preferences. See CentraSite in Setting the Preferences for Business Services.

5  Choose the Finish button.

| Note: If there are any problems, check the Error view for information.
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Verifying that Business Service Metadata was Added to CentraSite

After you have added business service metadata to CentraSite as described above, you can view
it in CentraSite's Asset Types view.

~ To verify that business service metadata has been added to CentraSite

Open the CentraSite Search and Browse perspective.

Go to the Asset Types view.

If necessary, refresh the view.

Select an NBS asset type.

& My CentraSit @ . H2 administratio | 2 Repository E | 22 Redistry Expl

< [#]

&4 O

[] [E EsE Document Type
[] £9esE Package

[] =+ EsE Service

[ % EesE specification
D ':,DESB WS Descriptor
[] .F 1DBC Datasource
|| Matural Library

|| Matural Subprogram
|&a| MBS Domain B
|5 MBS Service

4| MBS Steplib

Partlet ¥

OOEOO0

Click the # icon to display the asset in the Contents view.

[‘@Cnntents &3 E?Document Q)J'Search o I_Tﬁ‘] Q’.;(h B = =0
Aszets

Browse by: | [Mone] w |

Mame Description Status
IZ:::Z' DEMO. Calculator.w1. 1.1 Performs simple calculator funct...  submitted
£ 1UDDI Inquiry Services Web Service supporting UDDI L.,  submitted
DD Custody and Ownershi,..  Web Service providing partial s...  submitted
£ 1UDDI Publish API Services Web Service supporting UDDILP...  submitted
£ UDDI Security Service Web Service supporting UDDI 5...  submitted

¢ Tip: Open the context menu for an object in the Contents view. You can then invoke
a tool which displays a graphical impact analysis.
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5  Double-click the business service that you added to CentraSite to display the Summary page.

Summary

MBS Service O DEMO. Calculator. w1, 1.1

+ Details
Mame: DEMO. Calculator.w1. 1.1
Type: MBS Service

Description: Performs simple calculator functions. In addition a success flag is set if the solution is areater than the
success criteria, Additional information,

w Classified by

@ Category @ Taxonomy
{http:/inamespaces softwareag.com/nb...  ObjectType

« References

Association Type Object
HasParent ) DEMO
Ises ) cac

+ Technical Properties
Owner: AME\SACAME

Status Stability Expiration Major ¥e... = Minar Ve... Date Cr...
submitted dynamic 1 0 2009-10-...

Summar\;JGenerallPermissions Obiject-Specific Properties | Associations | MBS Metadata

6  Verify the associations in the References section.

7 Select the NBS Metadata tab at the bottom of the page to display additional information about
the service.

NBS Metadata

service_version: | 111

Summary |General |Permissions Object-Specific Properties | Assodations [NBS Metadata
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Showing the Preferences for Business Services

The preferences for business services are set in the Preferences dialog box of Eclipse.

~ To show the preferences for business services

1  From the Window menu, choose Preferences.
2 In the tree of the resulting dialog box, expand the Software AG node and then the Business

Services node.

Different pages are provided for setting different types of preferences.

4 Business Services
Centrasite
Installation

3  Select one of the pages in the tree and set the required options as described in the topics below.

4 Choose the OK button to save your changes and to close the dialog box.
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Business Services

Business Services - r v

General settings for Business Services.

Generation settings

Check for existing business service on Matural server

When generating a business service, the supporting rescurces (domains and steplib chain files)
can also be generated if they do not exist locally.

[/] Automatically generate supporting resources by downloading from Natural server

[¥] Autornatically generate supporting resources using default values

Download settings
Check for existing business service locally

When downloading a business service, the supporting rescurces (domains and steplib chain files)
and related subprograms can also be downloaded when they do not exist locally. Referenced
chbjects are not downloaded.

[¥] Autoratically download supporting resources from Matural server

[/] Automatically download related subprograms from Matural server

Upload settings

When upleading a business service, any supporting rescurce (dornain and steplib chain file) that
would cause the abnormal termination of the upload process can also be uploaded when it does
not exist on the server,

[T Automatically upload supporting resources

Generation Settings

The following options apply when you create new business services locally. See also Creating
New Business Services.

Check for existing business service on Natural server
When selected, the Natural server is checked for the existence of the business service being
generated. If it exists already, a warning message is shown.

Automatically generate supporting resources by downloading from Natural server
When selected, the domains and steplib chain files are automatically downloaded from the

Natural server if they do not yet exist locally.
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Automatically generate supporting resources using default values
When selected, the domains and steplib chain files are automatically generated using default
values if they do not yet exist locally.

| Note: This option only applies when Automatically generate supporting resources by

downloading from Natural server is not selected, or is selected but the resource does
not exist on the Natural server.

Download Settings

The following options apply when you download business services from a server. See also
Downloading Business Service Resources from a Server.

Check for existing business service locally
When selected, it is checked whether the selected business service already exists locally. If it
exists already, a warning message is shown.

Automatically download supporting resources from Natural server
When selected, the domains and steplib chain files are automatically downloaded from the
Natural server if they do not yet exist locally.

Automatically download related subprograms from Natural server
When selected, the subprograms which belong to a business service are automatically down-
loaded from the Natural server if they do not yet exist locally.

The referenced Natural objects such as DDMs or data areas, however, are not downloaded
automatically.

Upload Settings

The following option applies when you upload business services to a server. See also Uploading
the Business Service Resources.

Automatically upload supporting resources
When selected, the domains and steplib chain files are automatically uploaded if they do not
yet exist on the Natural server. This eliminates server exceptions that can prevent the selected
resources from being uploaded to the server.
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CentraSite

You can set up default values for the CentraSite connection. These values will be filled in automat-
ically on related panels, such as when the Add Metadata to CentraSite dialog box is displayed
(see Adding Business Service Definitions to CentraSite).

CentraSite =l v v

General settings for adding metadata to CentraSite.

Server settings

Servern
UserID:

Organization:

Server
Type the CentraSite connection path.

User ID
Type the user identification for CentraSite.

Organization
Type the name of the organization.

Installation

To function properly, certain UI functions require a Natural Business Services installation on the
Natural server. For example, the Business-Services root node in the Natural Server view can be
used to download business service resources from a Natural server to a local Natural project, but
only when there is a Natural Business Services installation on the server.

Installation = v w

General settings for Business Services installation,

Server installation

Some UI functionality (e.g. context rmenus, Matural Server view nodes, etc.) requires a Business
Services installation on the Matural server to function properly.

Make UI functionality visible based on product installation on the Matural server
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Make UI functionality visible based on product installation on the Natural server

When selected (default), the Ul functions are made visible based on the installation of Natural
Business Services on the server. To accomplish this, a server call determines which products
are installed on the server and the results are cached until the Software AG Designer shuts
down.

When deselected, all UI functions are visible, even when Natural Business Services is not in-
stalled on the server. No server calls will be made to determine which products are installed
on the server.
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